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Před zahájením provozu
Varování

Ověřovací klíč USB uchovávejte mimo dosah malých dětí.
Náhodné spolknutí může způsobit zranění.
●V případě požití vyhledejte ihned lékaře.

Bezpečnostní opatření při použití
Možnost poruchy při provozu může nastat:
● Pokud je k jednomu počítači připojeno více kabelů Micro USB
● Pokud s ověřovacím klíčem USB nebo kabelem Micro USB manipulujete mokrýma rukama
● Pokud je použit jiný kabel než vyhrazený kabel Micro USB
● Pokud je použit poškozený ověřovací klíč USB nebo kabel Micro USB

Ochranné známky a licence
●Microsoft, Windows a Windows Vista jsou buď registrované ochranné známky nebo ochranné známky společnosti Microsoft Corporation ve

Spojených státech amerických a/nebo dalších zemích.
● Snímky obrazovky produktu Microsoft přetištěny se svolením společnosti Microsoft Corporation.
● Intel® je ochranná známka společnosti Intel Corporation v USA a dalších zemích.
● Ostatní názvy, názvy společností a názvy produktů uvedené v těchto pokynech jsou ochranné známky nebo registrované ochranné

známky příslušných společností.
● Neoprávněná reprodukce tohoto softwaru je zakázána.
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Přehled
Úvod

Aplikace SYSTÉM ÚDRŽBY ELEKTRICKÝCH KOL je provozována 
na PC připojeném k elektrokolům za účelem diagnostiky pohonné 
jednotky, aktualizace firmwaru a provádění dalších operací.
Tuto aplikaci lze použít připojením PC ke konzoli na elektrokolech 
pomocí kabelu Micro USB (zástrčka typu B - standardní zástrčka A) 
(součást dodávky) a připojením ověřovacího klíče USB (součást 
dodávky) k počítači.

● Stránky, na které se odkazuje, jsou zobrazeny jako (→00).

Kompatibilní modely
Centrální řídicí jednotka (s typem portu USB) 
Řídicí jednotka předního rozbočovače (s typem portu USB)

Schéma zapojení

USB ověřovací klíč 
(součást dodávky) PC Konzole Řídící jednotka Baterie

Micro USB kabel (součást dodávky)

Provozní prostředí
(aktuální k červenci 2014)

CPU Alespoň Intel® Core™2 Duo nebo vyšší
OS Microsoft® Windows Vista® SP2 (32/64 bit)

Microsoft® Windows® 7 SP1 (32/64 bit)
Microsoft® Windows® 8 (32/64bit)

RAM OS 32 bit: 1 GB a více, OS 64 bit: 2 GB a více
Rozhraní IBM® PC/AT s porty USB2.0
HDD Alespoň 10 GB volného místa
Displej Barevný: 32 bit

Rozlišení: XGA (1024 x 768) nebo vyšší 
Multi-monitor: Podporován je pouze prim. monitor

Uživatel Je vyžadováno oprávnění správce
Název SYSTÉM ÚDRŽBY ELEKTRICKÝCH KOL

Ověřovací klíč Vyhrazený ověřovací klíč USB (součástí dodávky)
Propojovací 
Kabel

Vyhrazený kabel Micro USB (zástrčka typu B - 
standardní zástrčka A) (součást dodávky)

● I když jsou splněny systémové požadavky uvedené v tomto návodu
k obsluze, některé počítače nelze použít.

● Funkčnost nelze zaručit v operačním systému, se kterým aplikace
není kompatibilní.

● Provoz na upgradovaném OS není zaručen.
● Nelze zaručit provoz na počítači, který si zákazník sestavil sám.
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Instalace

1 Vložte CD-ROM (součást dodávky) do
jednotky počítače a otevřete Průzkumník.

2 Klikněte na [Maintenance].

3 Dvakrát klikněte na [setup.exe].
• V některých operačních systémech „Řízení uživatelských účtů“

se někdy zobrazí obrazovka. Pokud se zobrazí, vyberte [Ano].

4 Klikněte na [Next].

5 ●
Klikněte na   [Next] ( A ).
 Chcete-li změnit instalační adresář, klepněte na 
[Browse] ( B   a vyberte adresář.

B

A

6 Klikněte na [Next].
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Instalace

7 Klikněte na [Next].

8 Při akceptaci licenční smlouvy

poprvé vyberte [I accept this agreement-souhlas] ( C ) a 
klikněte na [Next] ( D ).

C
D

9 Klikněte na [Finish].

10Tím je instalace dokončena. Když
se zobrazí následující okno, 
klikněte na [Close].
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Provoz
Průběh operací
 Diagram - Průběh operací
Připojte kolo k 

PC
Zapněte 
konzoli

Spusťte 
aplikaci

Hlavní
obrazovka

Spusťte 
diagnostiku

[Console] Konzole

[Control unit] Motor a 
řídící jednotka

[Battery] baterie

Update-aktualizace

Electric bicycles system update

Maintenance System update

Settings-nastavení

Tipy
● Okna konzoly, řídicí jednotky (jednotka motoru) a baterie se zobrazí po spuštěním diagnostiky.
● Aktualizace systému údržby se spouští automaticky při spuštění aplikace.
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1 Jednotka displeje musí být řádně umístěna

do kolébky.

2 Otevřete gumovou krytku na spodní

straně jednotky displeje.

3 Připojte PC k displeji pomocí Micro USB
kabelu (součást dodávky) a stiskněte 
tlačítko napájení na displeji.

Důležité
Po ukončení aplikace vždy zavřete krytku ověřovacího 
klíče USB a gumovou krytku zobrazovací jednotky.

Provoz

Způsob připojení
 Způsob připojení LCD středového typu 
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Provoz

 Způsob připojení LCD bočního typu

1 Otevřete gumovou krytku na pravé straně
konzole.

2 Připojte počítač ke konzoli pomocí kabelu
Micro USB (součást dodávky) a stiskněte 
tlačítko napájení.

 Důležité
Po ukončení aplikace vždy zavřete krytku ověřovacího 
klíče USB a gumovou krytku zobrazovací jednotky..

 Způsob připojení LED konzole bočního typu

1 Otevřete gumovou krytku na pravé straně
konzole.

2 Připojte počítač ke konzoli pomocí kabelu
Micro USB (součást dodávky) a 
stiskněte tlačítko napájení.

 Důležité
Po ukončení aplikace vždy zavřete krytku ověřovacího 
klíče USB a gumovou krytku zobrazovací jednotky.
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1 Dvakrát klikněte na [Maintenance System]
ikonu na ploše.

Tipy
●Před spuštěním aplikace zkontrolujte spojení mezi PC a konzolí.

Provoz

 Způsob spouštění

2 Připojte ověřovací klíč USB (je součástí
dodávky) a klikněte na [OK].

Zobrazení v případě chybného ověření.

Tipy
●Pokud není ověřovací klíč USB rozpoznán, znovu připojte USB,

chvíli počkejte a poté restartujte.
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Provoz

  Pokud se zobrazí toto okno
Klikněte na [Ano] a proveďte aktualizace.
Způsob aktualizace naleznete v části „Aktualizace systému údržby ( (→18)”.

Tipy
●Chcete-li vypnout funkci automatického potvrzování aktualizace při spouštění aplikace, viz „Potvrzení při spuštění aktualizace (→21)”.
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Provoz

A B C D

A9 A10 A11 A12 A13 A14A6 A7 A8

A2A1

A3

A4

A5

E F G

Popis hlavní obrazovky
Na této obrazovce lze uložit rozhodnutí o kompenzaci i diagnostiku poruchy a přečíst si je po diagnostikování problému.

A
B
C
D
E
F
G
A1
A2
A3
A4

A5
A6
A7
A8
A9

Ikona [Hlavní obrazovka] (→12)
Ikona [Konzole] (→22)
Ikona [Motor a řídící jednotka] (→27)
Ikona [Baterie] (→29)
Informace o zařízení [Konzole]
Informace o zařízení [Řídící jednotka pohonu] 
Informace o zařízení [Baterie]
Tlačítko [Start diagnostiky] (→13)
Tlačítko [Opětovné zobrazení výsledků] 
Informace o výrobci
Informace výrobce  
(nezobrazeno pro model 2013)
Pole pro zadání informací o zákazníkovi 
Tlačítko [Vymazat] (→15)
Tlačítko [Uložit výsledky diagnostiky] (→15) 
Tlačítko [Číst diagnostické výsledky] (→15) 
Tlačítko [Tisk] (→16)

A10 Tlačítko [Pošta] (→17)
A11 Tlačítko aktualizace jízdního kola (→17)
A12 Tlačítko aktualizace aplikace (→18)
A13 Tlačítko [Aktualizace] (→18)
A14 Tlačítko [Nastavení] (→19)

Tipy
●Čísla ikon jsou použita i v následujících popisech.
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Provoz

Diagnostika pohonné jednotky 
Diagnostikujte závadu na pohonné jednotce.

Klikněte na tlačítko [Spustit diagnostiku](A1).
● Diagnostiku lze také provést výběrem [Nástroje] → [Diagnostika] v nabídce.
● Výsledky diagnostiky selhání lze znovu zkontrolovat kliknutím na [     ] (A2).

  Výsledek diagnostiky
● Pokud je výsledek diagnostiky normální, zobrazí se [OK].
● Pokud testování skončí chybně, zobrazí se [ERROR-CHYBA], [CHECK-KONTROLA] nebo [WARNING-VAROVÁNÍ]. Podrobnosti 
naleznete v části „Seznam výsledků diagnostiky (→31)”.
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Provoz

Pokud je napájení vypnuto před stisknutím tlačítka "spustit 
diagnostiku" nebo je odpojen kabel Micro USB, zobrazí se text 
[An error occurred during diagnosis-Došlo k chybě během 
diagnózy].
Pokud k tomu dojde, zkontrolujte připojení kabelu Micro USB 
nebo napájení konzoly a proveďte „Aktualizace připojení k
elektrokola (→18)”.

Vymazání chyb
Pokud se ve výsledcích diagnostiky zobrazí ERROR (CHYBA), 
CHECK (KONTROLA) nebo WARNING (VAROVÁNÍ), lze chybu 
odstranit pomocí [A15].

A15 Tlačítko [Vymazání chyb]

A15

Tipy
● U některých modelů nebude možné chyby odstranit.
● Není možné odstranit závažné chyby související s operací.
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Provoz

Ukládání výsledků diagnostiky

●  
● [Save diagnostic results-Uložit výsledky diagnostiky] v menu.

2 Pro uložení klikněte na [OK].
●Chcete-li změnit adresář pro ukládání

výsledků diagnostiky (→20)”.

Smazání výsledků diagnostiky

Kliknutím na [     ] (A6) smažete celý displej.

Čtení výsledků diagnostiky

●
● [Read diagnostic results-Přečíst výsledky diagnostiky] v menu.

2 Vyberte soubor ( 1 ), který chcete přečíst,
a klikněte na [Otevřít] ( 2 ).

2

1
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1 ● 
Klikněte na [     ] (A9).
    Diagnostické výsledky lze také vytisknout výběrem

 [File-Soubor] → [Print-Tisk] v nabídce.

o2  
Když se zobrazí okno s podrobnostmi

tisku, nastavte formát tisku a klikněte na [OK].

3 Podrobnosti budou vytištěny následovně.
Zadané údaje budou vytištěny na pozicích se stejným 
odpovídajícím číslem.

Pole pro zadání údajů o zákazníkovi ve spodní části hlavní obrazovky

1
2

3
5
7

8

4
6

Obrazovka Nastavení (Tisk)

9

10

11

Provoz

Tisk výsledků diagnostiky
Tištěné výsledky (sdílené)

1

3

4

9
10

11

5

27

6

8
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Provoz

Spuštění poštovního serveru
  Tato funkce spustí poštovní server.

Klikněte na [     ] (A10).
● Okno lze také zobrazit výběrem [Tools-Nástroje]

→ [Mail-Pošta] v menu.
Pokud jsou výsledky diagnostiky zobrazeny v části „Čtení 
výsledků diagnostiky (→15)”, budou tyto výsledky připojeny k 
e-mailu.

Aktualizace softwaru elektrokol
Tato funkce udržuje software, který testované elektrokolo používá, 
aktualizovaný na nejnovější verzi.

Klikněte na [     ] (A11) když probíhá 
komunikace mezi PC a elektrokolem.

●Okno lze také zobrazit výběrem [Update] →
[Update to the latest bicycle conditions] v menu.

 Důležité
Během aktualizace neodpojujte kabel USB ani nemačkejte 
tlačítka displeje.

Tipy
● Aktualizace bude trvat několik minut.

 Způsoby řešení selhání aktualizace
Řídicí jednotka (motorová jednotka) nemusí fungovat správně, 
pokud dojde k poruše během aktualizace kvůli vypnutí napájení 
displeje nebo odpojení kabelu Micro USB při provádění 
„aktualizace systému“.
Pokud k tomu dojde, použijte k řešení selhání následující metody.

1 Zkontrolujte připojení kabelu Micro USB
     i napájení displeje a klepněte na [      ] (A13).

 Pokud se aktualizace konzoly nezdaří

2 Zobrazí se dialogové okno [Upgrade the
console switch software].

 Pokud selže aktualizace řídicí jednotky (jednotky motoru).

2 Zobrazí se dialogové okno [Upgrade the
motor unit software].

3 Klikněte na [     ] (A11).
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Provoz

Aktualizace systému údržby
Tato funkce pro připojení k internetu udržuje aplikaci aktualizovanou 
na nejnovější verzi.

1 ● 
Klikněte na [     ] (A12).
    Aktualizace lze také spustit výběrem [Update] →

            [Diagnosis software update] v bar.

2 Klikněte na [Yes] pro zahájení aktualizace.

3 Aktualizace je spuštěna.

Tipy
● Používejte počítač připojený k internetu.

Aktualizace připojení elektrokola
 Tato funkce odstraňuje průběžné poruchy při diagnostice.

Pro opětovné připojení konzole a PC 
klepněte na [      ] (A13).
● Opětovné připojení lze také provést výběrem [Connect] →

[Reconnect] v menu.

Tipy
●Nepřipojujte k počítači konzolu dvou nebo více jízdních kol najednou.
●Připojení lze také aktualizovat klávesou F5.

Po úspěšném propojení se zobrazí [       ]. V tomto stavu lze 
využít diagnostiku a další různé funkce.
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Nastavení
Průběh operací

Diagram - Průběh operací v okně nastavení

Hl.obrazovka Settings Nastavení adr. pro 
ukládání výsledků diag.

Nastavení tisku

Síťová nastavení

Jazyková nastavení

Spuštění okna nastavení

Klikněte na [     ] (A14).
● Okno lze také zobrazit výběrem [Tools] → [Settings] v

menu.

A16
A20A17

A18
A19

A16 Diagnostika (→20)
A17 Tisk (→21)
A18 Sítě (→21)
A19 Jazyky (→21)
A20 Tlačítko [Procházet]

Tipy
●Čísla ikon jsou použita i v následujících popisech.
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Nastavení

Nastavení adresáře pro ukládání výsledků diagnostiky

1 Klikněte na [A16] a poté na [A20/         ].

2 Zadejte cílovou složku pro uložení a
klikněte na [OK].

3 ●
Klikněte na [OK].

Tím je nastavení adresáře pro ukládání dokončeno.
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Nastavení

Nastavení tisku

Klikněte na [A17 Print].
●Lze zadat pouze alfanumerické znaky.

Síťová nastavení 
Nastavení proxy

Klikněte na [A18 Network] pro změnu 
nastavení proxy.

 Důležité
● Toto změňte pouze v případě, že používáte proxy server.
● Tuto funkci by měl spustit správce systému.

Potvrzení aktualizace při spuštění
Zrušte zaškrtnutí políčka [A21 Zkontrolovat aktualizace softwaru 
při spuštění], pokud nechcete, aby se aktualizace systému údržby 
kontrolovaly při spuštění systému.

A21

Jazyková  nastavení

1 Klikněte na [A19 Languages].

2 Vyberte jazyk ze seznamu vpravo.

3 ●
Klikněte na [OK].

Restartování aplikace dokončí nastavení jazyka.
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B

B2 B3

B4

B1

Konzole
Průběh operací

Diagram - Průběh operací v okně konzoly

Hl.obrazovka Okno konzol [Device info-info o zařízení] Firmware update-aktualizace

[Settings-nastavení] Přepis parametrů

[Operation check-kontrola provozu] Spínač testů

Tipy
● Než otevřete obrazovku konzoly, proveďte diagnostiku závad.
● Karta [Settings-nastavení] se nezobrazuje pro LED konzoly bočního typu.

Okno konzole
V tomto okně lze aktualizovat konzolu, měnit nastavení a kontrolovat provoz.

B Ikona [Konzole]
B1 Přehled informací o zařízení
B2 Přehled nastavení
B3 Přehled informací o provozu
B4 Tlačítko pro aktualizaci firmwaru konzoly

Tipy
● Zobrazený obsah se může lišit v závislosti na modelu.
● Čísla ikon jsou použita i v následujících popisech.
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Konzole

 Aktulizace firmwaru

1 Klikněte na [      ] (B4) pro zobrazení okna
procházení složek.
● Okno lze také zobrazit výběrem [Update] → [Firmware

update] → [Console] v menu.

2 Vyberte složku obsahující firmware
a klikněte na [OK].
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Konzole

  Jak přepsat data konzole
Vyberte položku, kterou chcete přepsat
[B5], nastavte hodnotu pomocí [B6] a 
klikněte na [B7].

Tipy
● Přepisovatelná část se zobrazí červeně.
● Čísla ikon jsou použita i v následujících popisech.

Okno nastavení
Okno [Settings] se nezobrazuje pro LED konzoly bočního typu.

Klikněte na [B2 Settings].

B6

B7

B5

B5    Výběr položky přepisu
B6    Parametry nastavení
B7    Tlačítko [Zápis]



25(CZ)

Konzole

 Okno kontroly provozu

3 Zkontrolujte položky aktuálně zobrazené

v dialogovém okně testu konzoly.
4 Klikněte na [OK].

Pokud jsou výsledky diagnostiky normální, kontrolka se rozsvítí zeleně.

Pokud jsou výsledky diagnostiky abnormální, kontrolka se rozsvítí 
červeně.

Klikněte na [B3 Operation check].

 Test tlačítek konzole
Otestuje případné abnormality na tlačítkách a displeji konzoly .

1 Klikněte na [Switch test].

2 Stiskněte tlačítko na konzole odpovídající
ikoně, která bliká oranžově.

●Pokud je tlačítko úspěšně rozpoznáno, ikona testu tlačítka
se zobrazí zeleně. Pokud není úspěšně rozpoznáno,
rozsvítí se červeně.

Ikona se rozsvítí červeně a systém přejde k dalšímu testu 
pokud:
● Byl třikrát stisknut nesprávný spínač
● Po dobu 5 sekund nebylo stisknuto žádné tlačítko
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Motor a řídící jednotka
Průběh operací

Diagram - Průběh operací v okně řídicí jednotky (motorové jednotky).

Hl.obrazovka Okno motoru a 
řídící jednotky

[Device info]-info o zařízení Zápis parametrů

Aktualizace firmwaru

Zrušení autorizace

Smazání protokolu cest

Tipy
● Než otevřete okno řídicí jednotky (jednotky motoru), proveďte diagnostiku závad.
● Zobrazený obsah se může lišit v závislosti na modelu.
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Motor a řídící jednotka

C

C1

C2 C3 C4 C5

V tomto okně lze aktualizovat řídicí jednotku (jednotku motoru) a vymazat cestovní protokol.

C
C1
C2
C3
C4
C5

Ikona motoru a řídící jednotky
Přehled informací o zařízení
Tlačítko pro zápis parametrů
Tlačítko aktualizace firmwaru motoru 
Tlačítko zrušení autorizace
Tlačítko pro vymazání protokolu cest

Tipy
●Zobrazený obsah se může lišit v závislosti na

modelu.
●Čísla ikon jsou použita i v následujících popisech.
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Motor a řídící jednotka

  Jak přepsat parametry řídicí jednotky (motorové jednotky).
Klikněte na [     ] (C2), vyberte soubor s 
koncovkou frm a klikněte na [Open].

  Jak aktualizovat řídicí jednotku (jednotku motoru)
Klikněte na [     ] (C3), vyberte složku 
obsahující firmware a klikněte na [OK].

   Jak zrušit autorizaci konzoly a řídicí (motorové) jednotky

Klikněte na [      ] (C4).

● Tato funkce není aktuálně dostupná.   

     Jak smazat cestovní protokol

Klikněte na [      ] (C5).

Obnovte cestovní protokol na výchozí tovární nastavení.
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D

D1

D2

Baterie
Průběh operací

Diagram - Průběh operací v okně baterie 

Hl.obrazovka Okno baterie [Device info]-info o zařízení Test LED diod

Tipy
●Než otevřete okno baterie, proveďte diagnostiku závad.

D Ikona baterie
D1    Přehled informací o zařízení
D2    Tlačítko testu LED diod na baterii

Tipy
●Čísla ikon jsou použita i v následujících popisech.

Okno baterie
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Baterie

Přehled informací o zařízení

Klikněte na tlačítko [D1 Device info].
●V tomto okně lze zobrazit informace o baterii.

     Jak rozsvítit LED diody baterie

Klikněte na [      ] (D2).

Ostatní
Zobrazení informací o verzi 

Klikněte na [Help] → [About] v menu.

Jak ukončit aplikaci

Klikněte na [File] → [Exit] v menu.
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Seznam výsledků diagnostiky
Toto je podrobný seznam výsledků diagnostiky zobrazený v části „Diagnostika pohonné jednotky (→13)”.

Seznam výsledků diagnostiky konzole

Výsledek Příznak Protiopatření
ERROR 1. Aktualizace firmwaru se nezdařila 1. Znovu aktualizujte software konzoly pomocí aplikace pro údržbu

2. Vyměňte konzolu
ERROR 2. Došlo k vnitřní chybě v konzole Vyměňte konzolu
ERROR 3. V konzole byla detekována minulá vnitřní chyba Vyměňte konzolu
ERROR 4. Došlo k chybě ověřování mezi konzolou a motorovou

jednotkou (LCD konzole středového typu)
1. Zkontrolujte, zda jednotka motoru nevykazuje poruchu
2. Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou
3. Zkontrolujte, zda není znečištěný kontakt kolébky nebo kontakt zobrazovací 

jednotky
4. Zkontrolujte kombinaci zobrazovací jednotky a jednotky motoru
5. (Pokud byla vyměněna zobrazovací jednotka, proveďte proces resetování ověření)
6. Vyměňte konzolu

ERROR 4. Mezi konzolou a motorovou jednotkou došlo k chybě
ověřování (Jiné LCD konzole než středového typu)

1. Zkontrolujte, zda jednotka motoru nevykazuje poruchu
2. Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou
3. Vyměňte konzolu

ERROR 5. Došlo k chybě komunikace mezi konzolou a motorovou
jednotkou (LCD konzole středového typu)

1. Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou
2. Zkontrolujte, zda není znečištěný kontakt kolébky nebo kontakt zobrazovací jednotky
3. Vyměňte konzolu

ERROR 5. Došlo k chybě komunikace mezi konzolou a motorovou
jednotkou (Jiné LCD konzole než středového typu)

1. Zkontrolujte propojovací kabel mezi konzolou a motorovou 
jednotkou

2. Vyměňte konzolu
ERROR Tlačítko spínače DD je stisknuto nebo došlo ke zkratu 

ve spínači DD
1. Zkontrolujte, zda není stisknutý spínač DD, a vypněte napájení
2. Vyměňte konzolu

CHECK 7. Knoflíková baterie je vybitá 1. Vyměňte knoflíkovou baterii a nakonfigurujte nastavení hodin
2. Vyměňte konzolu

CHECK 8. Výpočet průměrné rychlosti selhal Vynulujte počítadlo kilometrů
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Seznam výsledků diagnostiky

Výsledek Příznak Protiopatření
CHECK 9. Byla zjištěna předchozí chyba v procesu aktualizace

softwaru
Je možné pokračovat

CHECK 10. Byla zjištěna předchozí chyba připojení pro
nepodporované zařízení USB

Je možné pokračovat

CHECK 11. Byla zjištěna předchozí chyba ověření mezi
konzolou a motorovou jednotkou

Je možné pokračovat

CHECK 12. Byla zjištěna předchozí chyba komunikace mezi
konzolou a motorovou jednotkou (středová LCD konzole)

1. Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou
2. Zkontrolujte, zda není znečištěný kontakt kolébky nebo kontakt
zobrazovací jednotky

CHECK 12. Byla zjištěna předchozí chyba komunikace mezi
konzolou a motorovou jednotkou (jiná než středová LCD
konzole)

Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou

CHECK 13Bylo zjištěno předchozí napájení stisknutím tlačítka DD Je možné pokračovat

OK 14. Konzole je v normálním stavu Je možné pokračovat
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Seznam výsledků diagnostiky

Seznam výsledků diagnostiky řídicí jednotky (motorové jednotky)

Výsledek Příznak Protiopatření
ERROR 1. Došlo k chybě komunikace s motorovou jednotkou 1. Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou

2. Vyměňte motorovou jednotku nebo konzolu
ERROR 2. Došlo k problému s firmwarem 1. Znovu aktualizujte firmware

2. Vyměňte motorovou jednotku
WARNING 2. Došlo k problému s firmwarem 1. Znovu aktualizujte firmware
WARNING 2. Došlo k problému s firmwarem 1. Znovu aktualizujte firmware
ERROR 3. Vyskytly se odchylky v hodnotách nastavení motorové

jednotky
Vyměňte motorovou jednotku

ERROR 4. Vyskytly se odchylky v hodnotách nastavení motorové
jednotky

Vyměňte motorovou jednotku

ERROR 5. Došlo k poruše momentového snímače Vyměňte motorovou jednotku
ERROR 6.  Došlo k poruše momentového snímače Vyměňte motorovou jednotku
ERROR 7.  Došlo k poruše momentového snímače Vyměňte motorovou jednotku
ERROR 8. Došlo k poruše snímače otáček jednotky motoru Vyměňte motorovou jednotku
ERROR 9. Došlo k poruše obvodu Vyměňte motorovou jednotku
ERROR 10.  Došlo k poruše obvodu Vyměňte motorovou jednotku
ERROR 11. Došlo k poruše v komponentu pro detekci teploty Vyměňte motorovou jednotku

ERROR 12. Došlo k poruše v komponentu pro detekci teploty Vyměňte motorovou jednotku

ERROR 13. Vyskytly se odchylky v hodnotách nastavení motorovét
jednotky

Vyměňte motorovou jednotku

ERROR 14. Došlo k poruše momentového snímače Vyměňte motorovou jednotku
ERROR 15. Došlo k poruše momentového snímače Vyměňte motorovou jednotku
ERROR 16. Došlo k poruše momentového snímače Vyměňte motorovou jednotku
ERROR 17. Došlo k poruše snímače otáček jednotky motoru Vyměňte motorovou jednotku
ERROR 18. Došlo k poruše obvodu Vyměňte motorovou jednotku
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Seznam výsledků diagnostiky

Výsledek Příznak Protiopatření
ERROR 19.  Došlo k poruše obvodu Vyměňte motorovou jednotku
ERROR 20. Došlo k poruše obvodu Vyměňte motorovou jednotku
CHECK 21.  Došlo k poruše momentového snímače 1. Nešlápněte na pedál při zapínání napájení

2. Vyměňte motorovou jednotku
CHECK 22.Došlo k poruše momentového snímače 1. Nešlápněte na pedál při zapínání napájení

2. Vyměňte motorovou jednotku
CHECK 23. Došlo k chybě ověření mezi baterií a motorovou

jednotkou
1. Zkontrolujte připojovací kabel baterie
2. Vyměňte baterii
3. Vyměňte motorovou jednotku

CHECK 24.  Došlo k chybě ověření mezi baterií a motorovou
jednotkou

1. Zkontrolujte připojovací kabel baterie
2. Vyměňte baterii
3. Vyměňte motorovou jednotku

CHECK 25. Došlo k chybě komunikace mezi konzolou
a motorovou jednotkou

1. Zkontrolujte připojovací kabel konzoly
2. Vyměňte konzolu

CHECK 26. Došlo k chybě komunikace mezi snímačem rychlosti
a motorovou jednotkou

1. Zkontrolujte propojovací kabel snímače rychlosti
2. Vyměňte snímač rychlosti

CHECK 27. Byla zjištěna chyba předchozího ověření mezi baterií
a motorovou jednotkou

Je možné pokračovat

CHECK 28.  Byla zjištěna chyba předchozího ověření mezi baterií
a motorovou jednotkou

Je možné pokračovat

CHECK 29. Motorová jednotka v minulosti dosáhla teplotního limitu Je možné pokračovat

CHECK 30. Motorová jednotka v minulosti dosáhla teplotního limitu Je možné pokračovat

CHECK 31. Baterie v minulosti dosáhla teplotního limitu Je možné pokračovat

CHECK 32. Baterie v minulosti dosáhla teplotního limitu Je možné pokračovat

CHECK 33. Byla zjištěna chyba komunikace mezi konzolou
a motorovou jednotkou

Je možné pokračovat
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Seznam výsledků diagnostiky

Výsledek Příznak Protiopatření
CHECK 34. Byla zjištěna předchozí chyba komunikace mezi

snímačem rychlosti a jednotkou motoru
Je možné pokračovat

WARNING 35. Byl detekován dřívější zkrat ve vedení Je možné pokračovat

WARNING 36. Byla detekována předchozí chyba snímače
otáčení pedálů

Je možné pokračovat

WARNING 37. Nízké napětí baterie Je možné pokračovat
WARNING 38.  Nízké napětí baterie Je možné pokračovat
WARNING 39. Bylo detekováno dřívější zapnutí systému při

při sešlápnutí pedálu
Aniž byste šlapali na pedál, stiskněte tlačítko napájení a zapněte systém

OK 40. Jednotka motoru je v normálním stavu Je možné pokračovat
WARNING 44. Zpracování nastavení systému se nezdařilo Znovu nahrajte továrního nastavení výrobce
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Seznam výsledků diagnostiky 

Seznam výsledků diagnostiky baterie

Výsledek Příznak Protiopatření
ERROR 1. Informace nelze získat z důvodu přerušení komunikace 

mezi konzolou a motorovou jednotkou
1. 1. Zkontrolujte propojovací kabel mezi konzolou a motorovou jednotkou
2. 2. Vyměňte motorovou jednotku nebo konzolu

ERROR 2. Komunikace mezi motorovou jednotkou a baterií 
není navázána

1. Proveďte přepis, pokud je problém s firmwarem motorové jednotky
2. Zkontrolujte propojovací kabel mezi motorovou jednotkou a baterií
3. Vyměňte baterii
4. Vyměňte motorovou jednotku

ERROR 3. Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 4.  Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 5.  Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 6.  Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 7.  Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 8.  Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 9. Normální nabíjení je nemožné kvůli degradaci článku Vyměňte baterii

ERROR 10. Normální nabíjení je nemožné kvůli degradaci článku Vyměňte baterii

ERROR 11.  Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
ERROR 12. Došlo k poruše v desce plošných spojů baterie Vyměňte baterii
CHECK 13. Byl detekován předchozí abnormální proud během 

vybíjení
Je možné pokračovat

CHECK 14.Byl detekován předchozí abnormální proud během
vybíjení

Je možné pokračovat

CHECK 15.  Byl detekován předchozí abnormální proud během
nabíjení

Je možné pokračovat

CHECK 16.Byl detekován předchozí abnormální proud během
nabíjení

Je možné pokračovat

CHECK 17. Byl detekován předchozí abnormální proud během
nabíjení

Je možné pokračovat

CHECK 18. Bylo detekováno předchozí používání při vysokých
teplotách 

Je možné pokračovat
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Seznam výsledků diagnostiky 

Výsledek Příznak Protiopatření
CHECK 19. Bylo detekováno předchozí používání při vysokých

teplotách 
Je možné pokračovat

CHECK 20. Bylo detekováno předchozí používání při vysokých
teplotách 

Je možné pokračovat

CHECK 21. Bylo zjištěno předchozí selhání ověření nabíječky Je možné pokračovat

CHECK 22.  Bylo detekováno předchozí používání při vysokých 
(nízkých) teplotách

Je možné pokračovat

OK 23. Baterie je v normálním stavu Je možné pokračovat
OK 24. Baterie je v normálním stavu Je možné pokračovat
OK 25. Baterie je v normálním stavu Je možné pokračovat

NYT1525
M0714-0

See the package for contact details
Manufactured by: Panasonic Cycle Technology Co., Ltd.
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